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Laboratorio Biblioteche Digitali 
 
Queste esercitazioni possono essere svolte utilizzando il sistema Greenstone v2.62 (o superiori). Il 
software e la documentazione relativa si possono scaricare al seguente indirizzo: 
http://www.greenstone.org/cgi-bin/library. 
Le esercitazioni richiedono una serie di documenti di prova che possono essere trovati sul sito del 
corso (http://pc-erato2.iei.pi.cnr.it/savino/Corso_bib_dig_06_07.htm). Per le esercitazioni in aula il 
materiale è disponibile in \\server-iu\File Condivisi\Savino\ LOCAL_TEST. 
Si suggerisce di copiare questi file in una cartella personale (ad esempio \\server-iu\Studenti_IU).  
 
In ogni caso, per svolgere le esercitazioni, è necessario che i file si trovino in una cartella locale 
del computer in uso. Si consiglia di copiare localmente le cartelle che sono utilizzate per ogni 
esercitazione. Nel seguito chiameremo la cartella locale LOCAL_TEST. 
 
Creare collezioni di documenti con Greenstone 
 
Parte I – Creare una collezione usando il Collector 
 

Trasferire i file in …\html_small in una cartella locale del vostro computer, ad es. c:\greenstone. 
Ci riferiremo a questa cartella con LOCAL_TEST. 
 
In questa prima esercitazione creeremo una Biblioteca Digitale costituita di file HTML che 
descrivono alcuni personaggi del Signore degli Anelli. I documenti si trovano nella cartella 
LOCAL_TEST\html_small 
 
Useremo il Collector per creare la collezione. Appena installato Greenstone non permette di 
accedere al Collector, quindi dobbiamo modificare le impostazioni di amministrazione del sistema.  
 

1. Lanciare la Greenstone Digital library 
 
Start -> Greenstone Digital Library -> Greenstone Digital Library 
 

2. Selezionare “Enter Library”; si entra così nella Greenstone homepage 
3. Nella home page selezionare il bottone “Administration Page” 
4. Tra i configuration files modificare il file main.cfg 
5. Viene chiesto lo user name e la password dell’amministratore:  

user name: admin 
password: admin 

6. Dopo aver premuto “sign in” viene aperto il file main.cfg 
7. Individuare la riga  

collector       disabled 
e sostituirla con 
collector       enabled 

8. quindi premere il bottone “Submit changes” 
9. Chiudere la Greenstone Digital Library per rendere effettivi i cambiamenti. 
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Ora possiamo creare la biblioteca digitale utilizzando il Collector. 
Accedere ai file html nella cartella usando explorer. 
 

1. Lanciare la Greenstone Digital library 
 
Start -> Greenstone Digital Library -> Greenstone Digital Library 
 

2. Selezionare “Enter Library”; si entra così nella Greenstone homepage 

3. Selezione “The Collector”, per creare una nuova collezione 

4. Inserire “username = admin” e “password = admin” 

5. Selezionare “sign in” 

6. Si accede ad una nuova pagina che permette di iniziare il processo di creazione della 
collezione 

7. Selezionare il bottone “Collection information” 

8. Si accede ad una pagina nella quale è possibile specificare le informazioni sulla collezione 

9. Inserire il titolo della collezione “HTML files small”, un indirizzo di mail, ed una breve 
descrizione della collezione. 

10. Alla fine selezionare il bottone “source data” 

11. Si accede alla pagina nella quale è possibile specificare quali file includere nella collezione. 

12. Specificare la cartella LOCAL_TEST\html_small (usare il path completo) 

13. Selezionare “configure collection” ed eliminare la riga contenente “plugin ImagePlug” 

14. Selezionare il bottone “build collection” ed attendere che il processo termini 

15. Quindi selezione “view collection” e provare ad accedere ai documenti inseriti nella 
collezione. 
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Parte II – Creare una collezione usando la Librarian Interface 
 
In questa esercitazione creeremo una Biblioteca Digitale costituita di file HTML che descrivono i 
Tudor. I documenti si trovano nella cartella LOCAL_TEST\html_large. 
Per avere un’idea dei documenti che faranno parte della collezione, provare ad aprire il file 
tudor.html nella cartella LOCAL_TEST\html_large\englishhistory.net. Si tratta 
di un sito, costituito da un file html principale con diversi link ad altre pagine html. In questa 
esercitazione creeremo un biblioteca digitale dell’intero sito. 
 

1. Chiudere la Greenstone Local Library, se è in esecuzione 

2. Lanciare la Greenstone Librarian Interface 
 
     Start -> Greenstone Digital Library -> Greenstone Librarian Interface 

 
3. Creare una nuova collezione 
 

     File -> New 
 

4. Una finestra richiede di specificare  
a. Collection title: 
b. Description of Content: 
 
Dopo aver inserito i valori richiesti, premere OK (lasciare il valore New Collection per 
Base this collection on) 

 
5. Si apre una finestra che richiede di specificare il modello di metadati da usare. Specificare 

“Dublin Core Metadata Element Set, Version 1.1 (dc)”, quindi OK. 

6. A questo punto bisogna specificare quali documenti inserire nella collezione. Attivare il 
Gather e, da Local Filespace individuare la cartella html_large. 

7. Spostare la cartella englishhistory.net dall’area Workspace a quella Collection. 

Se vengono visualizzati dei messaggi di warning selezionare <OK>. 

La copia richiede qualche tempo. Attendere che sia terminata. 

8. Nel panel Design selezionare Document Plugins tra le Design Sections ed eliminare il 
Plugin ImagePlug (selezionare la riga contenente “plugin ImagePlug”, quindi premere il 
bottone Remove). 

9. Passare alla sezione Create e lanciare la Build Collection. Quando termina l’operazione di 
costruzione, fare il preview della collezione. 

Esercizio 

• Provare ad accedere alla collezione appena creata. Quali modalità di browsing sono permesse? 

• Come sono organizzati i titoli dei documenti? 

• Che tipo di ricerche possono essere fatte? 
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Parte III – Creare una collezione di immagini 
 
In questo esempio creeremo una Biblioteca Digitale contenente immaginiLa collezione si trova 
nella cartella LOCAL_TEST\image-e. 
 
La collezione di immagini è già stata creata precedentemente, per cui basterà copiare la cartella 
LOCAL_TEST\image-e nella cartella che contiene tutte le collezioni Greenstone. 
Questa cartella si trova in ..\programmi\Greenstone\collect 
Copiare LOCAL_TEST\image-e in ..\programmi\Greenstone\collect 
 
Lanciare la Greenstone Digital Library e provare ad accedere alla collezione “Simple Image 
Collection”.  
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Parte IV – Aggiungere ed usare metadati  
 
Dopo aver creato la collezione di immagini, utilizziamo la Librarian Interface per aggiungere nuovi 
metadati e per usarli in fase di ricerca e di browsing. Modificheremo l’interfaccia per visualizzare i 
valori dei metadati inseriti e modificheremo la dimensione delle icone delle immagini. 
 

1. Chiudere la Greenstone Digital Library (se è aperta) 
2. Aprire il programma “Greenstone librarian interface” ed aprire la collezione contenente le 

immagini. 
 

File -> Open 
 
Tra le “available collections” selezionare quella appena creata nell’esercitazione precedente. 
(Si ricordi che il nome della collezione è “simple image collection”). 
 

3. La collezione che si è creata, utilizza solo metadati estratti automaticamente. In particolare, 
utilizza il plug-in ImagePlug che crea automaticamente un’icona per ogni immagine ed 
estrae i seguenti metadati:  

 Image             Name of file containing the image  
 ImageWidth Width of image (in pixels)  
 ImageHeight Height of image (in pixels)  
 Thumb             Name of gif file containing thumbnail of image  
 ThumbWidth Width of thumbnail image (in pixels)   
 ThumbHeight Height of thumbnail image (in pixels)   
 thumbicon Full pathname specification of thumbnail image   
 assocfilepath Pathname of image directory in the collection's assoc directory  
            Aggiungiamo quindi il set di metadati Dublin Core.  

4. Greenstone permette di utilizzare diversi insiemi di metadati. Per aggiungere un nuovo 
insieme si seleziona il panel “Design” e quindi la sezione “Metadata Sets”. A questo punto 
si seleziona il bottone “Add Metadata Sets” e, tra i vari set si sceglie “dublin.mds”, quindi 
“Add Metadata Set”. 

5. Visualizzare la finestra “enrich”. Per ogni file vi sono ora i campi Dublin Core (prefisso dc.) 
e quelli estratti automaticamente (prefisso ex.) 

6. Nell’esempio utilizzeremo solo i primi tre file (ascent.jpg, autumn.jpg, azul.jpg) 
(Ovviamente si possono aggiungere metadati a tutti i file presenti). Inseriamo un valore per 
il campo dc.Title. Per ogni file inseriremo come valore il nome del file, senza l’estensione 
del filename. 

7. Selezionare Ascent.jpg e quindi selezionare dc.Title sulla parte destra della finestra. 
Selezionare il campo testuale “Value field”, ed inserire il valore “Ascent”. 

8. Ripetere lo stesso procedimento per Autumn.jpg e Azul.jpg 

9. Selezionare tutta i file (si può selezionare il primo file e quindi con il tasto Maiusc premuto 
si selezional’ultimo). Selezionare dc.Creator ed inserire il nome dell’autore della 
collezione (per es. il vostro nome).  

In questo modo il valore del metadato viene associato a tutti i file contenuti nella cartella. 

10. Provare a creare la collezione (Build Collection) ed a visualizzarla (Preview Collection). 
Non si nota nessuna differenza rispetto a prima, poiché non è stata modificata la modalità di 
visualizzazione della collezione per visualizzare i nuovi metadati. 
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11. Nel Design panel selezionare il bottone “Format Features”. Modificare il formato della 
VList: 

 
Cambiare “Image name:” in “Titolo:”  
Cambiare “[Image]” in “[dc.Title]” 
Aggiungere “Autore: [dc.Creator]<br>” dopo “[dc.Title]<br>” 
 
Sostituire i  <br> tra Width, Height, e Size con tre spazi bianchi. 
 
Nota: le maiuscole nei nomi dei metadati sono importanti, quindi scrivere esattamente 
dc.Title. 
 
Premere <Replace Format>. La prima sostituzione modifica il frammento di testo che appare 
alla destra dell’immagine, la seconda modifica il metadato che viene visualizzato (da 
[Image] a [dc.Title]), la terza visualizza il valore del metadato [dc.Creator]. 
 
Il risultato finale sarà il seguente: 
 

<td valign='top'>[link][thumbicon][/link]</td> 
<td valign='top'>Titolo: [dc.Title]<br>Autore: [dc.Creator]<br> 
_Width_: [ImageWidth] 
<br>_Height_: [ImageHeight]<br>_Size_: [ImageSize]</td> 

 
Creare la collezione e visualizzarla. Facendo “browsing” dei file della collezione, si 
dovrebbero visualizzare le immagini con i metadati “dc.Title” e “dc.Creator”. Solo le prime 
tre immagini hanno un valore per dc.Title, mentre dc.Creator è lo stesso per tutte le 
immagini. 
 

12. Modifichiamo ora la dimensione dell’icona delle immagini, rendendola più piccola. Le 
icone delle immagini vengono create dal plug-in ImagePlug, per cui è necessario accedere ai 
parametri di configurazione per modificarlo. Accedere al Design panel e selezionare 
Document Plugins dalla lista sulla sinistra. Fare doppio click sul plug-in ImagePlug per 
visualizzare la finestra con i parametri di configurazione. Selezionare thumbnailsize, ed 
inserire il valore 50, quindi premere <OK>. Build e preview della collezione. La dimensione 
delle icone ora risulta più piccola. 

13. Ora aggiungeremo dei metadati che descrivono le foto della collezione. Anche in questo 
caso ci limiteremo alle prime tre immagini (Ascent.jpg, Autumn.jpg, Azul.jpg). Selezionare 
il panel Enrich e l’immagine Ascent.jpg. Inserire una descrizione dell’immagine 
nell’elemento dc.Description. 
 
Per scegliere la descrizione visualizzare l’immagine o facendo doppio click su di essa, o 
dalla finestra di preview della collezione. Una possibile descrizione potrebbe essere “Luna 
che sorge da dietro le montagne. Panorama.”. (Potete comunque  inserire una descrizione a 
vostra scelta). 
 

14. Ripetere il procedimento per Autum.jpg e Azul.jpg 

15. Ora modifichiamo il formato di visualizzazione per utilizzare il nuovo campo 
dc.Description. Selezionare il panel Design e selezionare Format Features dalla lista di 
sinistra. Lasciare gli Editing Controls al valore di default: Choose Feature è vuota e 
l’Affected Component è Vlist. Nella HTML Format String posizionare il cursore dopo 
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[dc.Title]<br> 
 
ed inserire il testo seguente: 
 
Descrizione: [dc.Description]<br> 
 
Quindi premere <Replace Format>. 
 

16. Build e Preview. Adesso ogni immagine dovrebbe avere la propria descrizione. 

17. Adesso inseriremo una nuova opzione di browsing basata sulla descrizione. Selezionare il 
Design panel e selezionare Browsing Classifiers dalla lista di sinistra. Dalla lista “select 
classifier to add” scegliere “AZList”, quindi selezionare Add classifier. 

Nota: Questa procedura inserisce un nuovo classificatore alfabetico (AZList). 

18. Viene visualizzata una finestra con le opzioni del classifier. Selezionare dc.Description nel 
campo metadata. Selezionare buttonname ed inserire “descriptions” nella casella di testo. 
Quindi selezionare <OK>. Infine creare e visualizzare la collezione. Nella navigation bar vi 
è un nuovo bottone. Selezionarlo. 

Vengono visualizzate solo le immagini per le quali è stato inserita una descrizione. 

19. Adesso costruiremo un indice, sul quale possono essere effettuate delle ricerche, basato sul 
metadato dc.Description. Tornare al Design panel e selezionare Search Indexes dalla lista di 
sinistra. Come “index name” inserire “descriptions” e selezionare dc.Description, quindi 
premere <Add Index>. 

20. Creare e visualizzare la collezione. Provare ad effettuare delle ricerche sul campo 
descriptions.  

 
Esercizio 
 

1. Si provi ad aggiungere una data per alcuni file della collezione ed a visualizzarla insieme ad 
ogni immagine. Le date vanno specificate nella forma aaaammgg (ad esempio, 20040527 
per il 27 Maggio 2004). 

 
2. Si provi quindi a creare un classificatore per la data. 

 
3. Si provi ad inserire un indice di ricerca sulla data. 
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Parte V – Come modificare il logo della collezione  
 
Come modificare i logo della home page e della pagina della collezione 
 

1. Nel panel Design selezionare la sezione General 
2. Alla voce “URL to about page icon” selezionare il file “inf_um_large” nella 

cartella “LOCAL_TEST\immagini logo” 
3. Alla voce “URL to about page icon” selezionare il file “inf_um_small1” nella 

cartella “LOCAL_TEST\immagini logo” 
4. Build e preview 
5. Provare a visualizzare anche la home page della Greenstone Digital Library. 

 
Come controllare il processo di costruzione di una collezione  

1. Quando si crea una nuova collezione sono necessari numerosi cicli di creazione, 
visualizzazione, aggiustamento, ecc. In questa fase è utile limitare il numero di documenti 
nella collezione. Questo si può determinare attraverso il parametro “maxdocs” nel processo 
di costruzione. 

2. Nel panel Create selezionare Import dalla lista di sinistra. Nelle opzioni visualizzate 
selezionare maxdocs e fissare il suo valore a 3. Quindi Build. 

3. Visualizzando la collezione, ora sono disponibili solo tre documenti. 
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Parte VI – Utilizzo dei classificatori 
In questo esercizio verranno aggiunte funzionalità di ricerca sul testo – basata sul classificatore 
PHIND. 

Quindi, creeremo un indice per la ricerca di frasi nel testo.  

Inoltre creeremo una partizione degli indici in modo da poter restringere le ricerche a sottoparti 
dell’intera collezione. 

Infine, assegneremo dei valori di metadati organizzati gerarchicamente e creeremo un classificatore 
che permette di fare browsing su questi metadati. 
 
Costruzione della collezione tudorX 

1. Creare una nuova collezione di nome tudorX. Utilizzare Dublin Core come set di metadati. 

2. Nel panel Gather aprire la cartella html_large nella cartella test_files e copiare 
englishhistory.net nella nuova collezione. 

3. Eliminare il plug-in ImagePlug. 

4. Build e preview della collezione 

Aggiungere il classificatore PHIND per la ricerca di frasi nel testo 
5. Per aggiungere il classificatore PHIND, nel panel Design selezionare Browsing Classifiers. 

(PHIND crea un indice gerarchico ed interattivo di frasi) 

Scegliere Phind dal menu Select classifier to add. Click Add Classifier. Viene visualizzata 
una finestra che permette di specificare le opzioni di configurazione: lasciare tutti i valori di 
defaults (questo creerà l’indice delle frasi sul full text), quindi click <OK>. 

Eliminare (remove) il classificatore per il metadato Source dalla lista dei classificatori 
assegnati (questo classificatore è poco significativo in questo esempio).  

Build della collezione e preview. Provare l’opzione di ricerca di phrases (ad esempio 
iniziare la ricerca con il termine king). 

 
Creazione di un indice per la ricerca di frasi 
 
Creeremo ora un diverso indice per la ricerca di frasi (fielded search). Mentre l’indice creato con 
PHIND permette il browsing gerarchico delle frasi contenute nei documenti, l’indice che creeremo 
ora permette di specificare esplicitamente le frasi da cercare. Inoltre, in questo caso è possibile 
effettuare ricerche di più frasi connesse con gli operatori AND, OR. In questo caso si userà il 
classificatore MGPP. 
 

6. Nel panel Design selezionare la sezione Search Types, quindi abilitare Enable Advanced 
Searches. Premere il bottone Add search type. 
 
Quando viene abilitata questa opzione è possibile effettuare delle “fielded search”.  
 

7. Build e preview. 

8. Provare ad eseguire delle ricerche su frasi, ad esempio1: 

•  “Tudor Monarchs” OR “King Henry” 

                                                 
1 Si ricordi di abilitare la modalità di visualizzazione delle form search nel menu Preferences. 
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• “Tudor Monarchs” AND “King Henry” 

• È possibile effettuare le stesse ricerche con gli indici creati da PHIND? Quale è la 
differenza tra i due sistemi di ricerca di frasi? Quale è il vantaggio (e svantaggio) di 
un metodo rispetto all’altro? 

• Provare la modalità di ricerca “avanzata” (selezionare “Preferences”, quindi “Form  
type = advanced”) 

Creazione di una partizione degli indici. 
In questo caso creeremo tre partizioni degli indici, per poter effettuare ricerche in diverse aree della 
collezione. 

9. Passare alla modalità “Library Systems Specialist”. Nel File menù selezionare “Preferences” 
e nel panel “Mode” specificare “Library Systems Specialist”. 

10. Selezionare Partition Indexes dal panel Design. Definire i seguenti filtri (selezionare 
Define filters). Questa operazione permette di definire dei criteri per la selezione (filtri) di 
files da aggiungere alle diverse partizioni. Questi filtri vengono specificati attraverso delle 
espressioni regolari espresse sui nomi dei file o sui valori dei metadati: 

• Creazione del filtro “monarchi”. Questo filtro permette di selezionare tutti i 
documenti presenti nella cartella monarchs. Nella casella subcollection filter name 
inserire monarchi. In document attribute to match against selezionare Filename. 
In regular expression to match with inserire monarchs. In what to do with files 
that match selezionare include. Quindi premere Add filter. Si è quindi creato il 
seguente filtro sucollection monarchi “Filename/monarchs”. 

Questo filtro crea una sottocollezione di nome “monarchi”, costituita da tutti i file 
che contengono nel nome la parola “monarch”.  

• Con lo stesso procedimento creare il filtro “parenti” che selezioni tutti i documenti 
contenuti nella cartella relative. 

• Creare il filtro “altri” che permette di selezionare tutti i documenti che non si trovano 
ne nella cartella monarchs ne in quella relative. In questo caso in regular 
expression to match with inserire (monarchs | relative). In what to do with files 
that match selezionare exclude. 

11. Passare alla sezione Assign Partitions di Partition Indexes. In questa sezione è possibile 
creare le partizioni i cui documenti sono stati selezioni dai filtri specificati precedentemente. 
Aggiungere tre partizioni, una per ogni filtro: monarchi, parenti, altri. 

12. Build e preview della collezione. Verificare i cambiamenti avvenuti nella search. Provare 
ad effettuare ricerche solo in una partizione (ad es. ‘Mary’ nella partizione “parenti” e nella 
partizione “monarchi”). 

Esercizio 

Si provi ad associare un autore ad alcuni file html della collezione ed un diverso autore ad altri. Si 
creino quindi delle partizioni di ricerca diverse per i due autori. 

Come inserire una gerarchia di soggetti 
 
Ora aggiungeremo dei valori di metadati organizzati gerarchicamente. Quindi costruiremo un 
classificatore che permette di fare browsing su questi metadati. Il campo di metadati che verrà 
utilizzato è dc.Subject. La gerarchia di valori permessi è la seguente: 
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13. Nel Panel Enrich, selezionare il folder “citizens” e selezionare dc.Subject. Inserire il valore 

“Tudor Period|Citizens”, quindi premere Append. Con l’utilizzo di “|” è possibile creare 
gerarchie di valori di metadati. Si noti che assegnando un valore ad un metadato di un 
folder, tale valore viene ereditato da tutti i documenti contenuti nel folder. 

14. Ripetere il procedimento per i folder “monarchs” e “relatives”, assegnando rispettivamente i 
subject “Tudor Period\Monarchs” e “Tudor Period|Relatives”. 

15. Ai passi 13. e 14. si sono assegnati valori al metadato “dc.Subject and Keywords” a tutti i 
documenti contenuti nei folder Citizens, Monarchs e relatives. L’uso della forma 
nome|nome permette di creare strutture gerarchiche di metadati. 

16. Nel panel Design aggiungere un Hierarchy classifier nella sezione dei Browsing 
Classifiers. Specificare buttonname = Subject, e come metadata = “dc.Subject.and 
Keywords”.  

17. Build e preview 

 

Esercizio 
• Provare ad accedere alla collezione e ad utilizzare il browsing per Subject. 
• Provare ad assegnare una data a gruppi diversi di documenti e quindi creare uno Hierachy 

Classifier per le date. 
• Come vengono visualizzate le date in questo caso? 
• Come si dovrebbero assegnare le date ai diversi file in modo che vengano visualizzate nella 

seguente forma? 
 

 

Tudor Period 

Citizens Monarchs Relatives 
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Parte VII – Utilizzo dei classificatori (cont.) 
 
In questa esercitazione creeremo una collezione di dati bibliografici, tratti dalla Library of Congress 
e rappresentati in formato MARC. Si farà uso del classificatore AZCompactList per creare una 
struttura di browsing per il metadato Subject. 
 

1. Creare una nuova collezione denominata “Beatles Bibliography” che conterrà record 
bibliografici sui Beatles, tratti dalla Library of Congress. Non includere alcun set di 
metadati. 

2. Nel panel Gather, aprire il folder sample_marc ed includere nella collezione il file 
locbeatles50.marc, trasferendolo nella parte destra dello schermo. 

Locbeatles50.marc contiene 50 record bibliografici, tutti raggruppati nello stesso file. 

Quando si include il file viene chiesto se aggiungere il plug-in per gestire record in formato 
MARC. Questo plugin permette di analizzare record in formato MARC e di estrarre 
automaticamente un insieme di valori per diversi metadati, tra cui Source, Title, Subject 

3. Build e preview della collezione 

4. Rimuovere i plugin da TextPlug a PSPlug (al di sopra della linea di divisione, rimangono 
solo i plugin ZIPPlug, GAPPlug e MARCPlug). Questi plugin non sono sicuramente 
utilizzati, per cui è buona pratica eliminarli, anche se non è strettamente necessario.  

5. Selezionare la sezione Browsing Classifiers del Design panel e rimuovere il classificatore 
per il metadato Source. In questa collezione, tutti i record sono tratti da un unico file, per cui 
questo metadato non è significativo. 

6. Nel Create panel, fare build e preview della collezione. Provare a fare browsing tra i titoli 
presenti utilizzando titles a-z; visualizzare qualche record. 

7. Aggiungere un classificatore AZCompactList per il metadato Subject. Nel panel Design, 
sezione Browsing Classifiers, in select classifier to add, selezionare AZCompactList e 
quindi click <Add Classifier>. Nella finestra che viene visualizzata, selezionare ex.Subject 
come metadato, e selezionare l’opzione mingoup con valore 1. 

Il classificatore AZCompactList ha un comportamento simile a quello di AZList; l’unica 
differenza consiste nel fatto che termini che appaiono più volte nella gerarchia sono 
automaticamente raggruppati insieme e viene formato un nuovo nodo rappresentato 
dall’icona dello scaffale. Avendo posto mingroup=1, implica che il gruppo viene creato 
anche se è presente un solo elemento. 

8. Build della collezione e preview del risultato. 

9. Ora modificheremo leggermente la visualizzazione del classificatore AZCompactList, 
presentando anche il numero di elementi contenuto in ogni gruppo. Questo si ottiene 
modificando il formato delle VList, con la seguente procedura: 

a. Nel panel Design, sezione Format Features, selezionare la riga contenente il 
formato della VList  

b. Nell’ HTML Format String, aggiungere  
{If}{[numleafdocs],<td><i>([numleafdocs])</td>} 

Subito prima della stringa </td> finale. 

Questo comando dice che se numleafdocs è diverso da zero, allora viene 
visualizzato ([numleafdocs]) 
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Click <Replace Format> 

10. Nel Create panel, selezionare Preview (non è necessario ripetere il build della collezione). 

11. Aggiungere la funzione di fielded search, seguendo i passi 6-7 della parte VI. 
 
Aggiunta di una immagine che rappresenti la collezione 
 
In questa parte dell’esercitazione, aggiungeremo un’immagine logo che rappresenterà la collezione 
nella home page di Greenstone e nella parte in alto a sinistra su ogni pagina della collezione. 

12. Aprire una finestra Windows con il file della cartella sample_marc 

Aprire la cartella Program Files\gsdl\collect\beatlesb che contiene i dati della collezione. 

Copiare i file beatles_logo.jpeg e beatles_flick.gif dalla cartella sample_marc in beatlesb. 

13. Nella Librarian Interface, nel Design panel, selezionare la sezione General 

14. In URL to about page icon, attraverso il bottone Browse, selezionare il file 
beatles_logo.jpeg che si trova nella cartella LOCAL_TEST/sample_marc 

15. Ripetere il procedimento per URL to home page icon usando il file 
beatles_flick.gif presente nella cartella LOCAL_TEST/sample_marc 

16. Build e preview della collezione. 
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Parte VIII – Partizionamento dell’indice full-text sulla base di valori dei 
metadati 
 

In questa esercitazione creeremo una nuova collezione Tudor e partizioneremo l’indice per la 
ricerca full-text in quattro parti separate. Per fare questo definiremo 4 sottocollezioni ottenute 
“filtrando” i documenti sulla base dei valori dei metadati nel campo dc.Subject and Keywords. 
Quindi assegneremo un idice ad ogni sotto-collezione. Questo ci permetterà di limitare la ricerca 
ad un sottoinsieme dei documenti. 

Costruzione della collezione tudor 
1. Creare una nuova collezione di nome tudor. Utilizzare Dublin Core come set di metadati. 

2. Nel panel Gather aprire la cartella html_large nella cartella test_files e copiare 
englishhistory.net nella nuova collezione. 

3. Eliminare il plug-in ImagePlug. 
4. Nel Panel Enrich, selezionare il folder “citizens” e selezionare dc.Subject. Inserire il valore 

“Tudor Period|Citizens”, quindi premere Append. Ripetere il procedimento per i folder 
“monarchs” e “relatives”, assegnando rispettivamente i subject “Tudor Period|Monarchs” e 
“Tudor Period|Relatives”. Selezionare tutti i documenti che non appartengono a nessuna 
delle cartelle ed assegnare ad essi il valore “Tudor Period|Others” per il metadato 
dc.Subject. 

5. Build e preview della collezione 
 
Creazione del partition index 

6. Aprire la collezione tudor. 
7. Passare al Design panel, e selezionare Partition Indexes. Questa funzionalità è disabilitata 

se si opera nella modalità Librarian (la modalità è indicata nella title bar della finestra).  
8. Passare alla modalità Library Systems Specialist selezionando Preferences nel File menu 

e specificando <Mode>.  
9. Ritornare alla sezione Partition Indexes del Design panel. Assicurarsi che il tab Define 

Filters sia selezionato. Definire un subcollection filter con nome monarchs che selezioni 
sulla base dei valori del metadata dc.Subject and Keywords, e specificare Monarchs come 
espressione regolare. Click <Add Filter>.  Questo filtro seleziona tutti i file per I quali il 
valore del metadato dc.Subject and Keywords contiene la parola Monarchs.  

10. Definire un altro filtro, relatives, che seleziona i file per i quali dc.Subject and Keywords 
corrisponde a Relatives. Definire un terzo ed un quarto filtro, citizens ed others, che 
corrispondono rispettivamente alle parole Citizens and Others.  

11. Dopo aver definito i filtri per le sottocollezioni, partizioniamo l’indice nelle corrispondenti 
parti. Click sul tab Assign Partitions. Selezionare la sottocollezione citizens e click <Add 
Partition>. Quindi selezionare monarchs, e click <Add Partition>. Ripetere per le alter due 
sottocollezioni così da ottenere 4 partizioni, ognuna basata su un filtro diverso.  

12. L’ordine con il quale le partizioni compaiono nella lista Assigned Subcollection Partitions 
corrisponde all’ordine con il quale esse saranno visualizzate nel menu a tendina nella pagina 
di ricerca.  Si può modificare l’ordine usando i bottoni <Move Up> e <Move Down>.  

13. Build e preview della collezione.  
14. La search page include un menu a tendina che permette di selezionare una delle partizioni 

per la ricerca. Per esempio, si provi a cercare i documenti con la parola mary nella partizione 
relatives e quindi nella partizione monarchs.  
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15. Supponiamo che si voglia consentire agli utenti di effettuare delle ricerche nell’intera 
collezione, oltre che nelle diverse sottocollezioni. Si torni quindi alla sezione Partition 
Indexes del Design panel e si selezioni il tab Assign Partitions. Si selezionino tutte le 4 
sottocollezioni e quindi fare click su <Add Partition>.  

16. Per assicurarsi che l’indice composto compaia per primo nella pagina web della collezione, 
usare il bottone <Move Up> per spostarlo in cima alla lista, nel Design panel. Quindi build 
e preview della collezione.  

17. Si provi a cercare una parola comune (ad es. the) in tutte le 5 partizioni, e verificare che la 
somma del numero delle parole (non dei documenti) nelle 4 partizioni iniziali è uguale al 
numero di parole nella partizione globale.  

18. Il testo che compare nel menu a tendina usato per la ricerca corrisponde al nome dei filtri 
usati per la costruzione di ogni partizione. Per modificare il testo che viene visualizzato  selezionare 
la sezione “Assign Partitions” nel panel “Partition Indexes”. Assegnare alla partizione contenente 
tutti i documenti il nome “all”. Preview della collezione. 
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Parte IX – Una collezione multimediale 

In questa esercitazione preveremo ad utilizzare una collezione multimediale già pronta. 

1. Copy the entire folder  

sample_files → beatles → advbeat_large  

(with all its contents) into your Greenstone collect folder. If you have installed Greenstone 
in the usual place, this is  

My Computer → Local Disk (C:) → Program Files → Greenstone → collect  

Put advbeat_large in there.  

2. If the Greenstone Digital Library Local Library Server is already running, re-start it by 
clicking the CD icon on the task bar and then pressing Restart Library. If not, start it up by 
selecting Greenstone Digital Library from the Start menu.  

3. Explore the Beatles collection. Note how the Browse button divides the material into seven 
different types. Within each category, the documents have appropriate icons. Some 
documents have an audio icon: when you click these you hear the music (assuming your 
computer is set up with appropriate player software). Others have an image thumbnail: when 
you click these you see the images.  

4. Look at the Titles browser. Each title has a bookshelf that may include several related items. 
For example, Hey Jude has a MIDI file, lyrics, and a discography item.  

5. Observe the low quality of the metadata. For example, the four items under A Hard Day's 
Night (under "H" in the Titles browser) have different variants as their titles. The collection 
would have been easier to organize had the metadata been cleaned up manually first, but that 
would be a big job. Only a tiny amount of metadata was added by hand—fewer than ten 
items. The original metadata was left untouched and Greenstone facilities used to clean it up 
automatically. (You will find in Building a multimedia collection that this is possible but 
tricky.)  

6. In the Windows file browser, take a look at the files that makes up the collection, in the  

sample_files → beatles → advbeat_large → import  

folder. What a mess! There are over 450 files under seven top-level sub-folders. 
Organization is minimal, reflecting the different times and ways the files were gathered. For 
example, html_lyrics and discography are excerpts of web sites, and images contains various 
images in JPEG format. For each type, drill down through the hierarchy and look at a 
sample document.  
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Parte X – Creazione di una collezione multimediale 

We will proceed to reconstruct from scratch the Beatles collection that you have just looked at. We 
develop the collection using a small subset of the material, purely to speed up the repeated 
rebuilding that is involved.  

1. Start a new collection (File → New...) called small beatles, basing it on the default -- New 
Collection --. (Basing it on the existing Advanced Beatles collection would make your life 
far easier, but we want you to learn how to build it from scratch!)  

2. Copy the files provided in  

sample_files → beatles → advbeat_small  

into your new collection. Do this by opening up advbeat_small, selecting the eight items 
within it (from discography to beatles_midi.zip), and dragging them across. Because some 
of these files are in MP3 and MARC formats you will be asked whether to include 
MP3Plug and MARCPlug in your collection. Click <Add Plugin>.  

3. Change to the Enrich panel and browse around the files. There is no metadata—yet. Recall 
that you can double-click files to view them.  

(There are no MIDI files in the collection: these require more advanced customisation 
because there is no MIDI plugin. We will deal with them later.)  

4. Change to the Create panel and build the collection.  

5. Preview the result.  

Manually correcting metadata  

6. You might want to correct some of the metadata—for example, the atrocious misspelling in 
the titles "MAGICAL MISTERY TOUR." These documents are in the discography section, 
with filenames that contain the same misspelling. Locate one of them in the Enrich panel. 
Notice that the extracted metadata element ex.Title is now filled in, and misspelt. You 
cannot correct this element, for it is extracted from the file and will be re-extracted every 
time the collection is re-built.  

7. Instead, add dc.Title metadata for these two files: "Magical Mystery Tour." Change to the 
Enrich panel, open the discography folder and drill down to the individual files. Set the 
dc.Title value for the two offending items.  

Now there's a twist. The dc.Title metadata won't appear in Titles because the classifier has been 
instructed to use ex.Title. But changing the classifier to use dc.Title would miss out all the extracted 
titles! Fortunately, there's a way of dealing with this by specifying a list of metadata names in the 
classifier.  

8. Change to the Design panel and select the Browsing Classifiers section. Double-click the 
ex.Title classifier (the first one) to edit its configuration settings.  

• Type dc.Title, before the ex.Title in the metadata box—i.e. make it read  
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dc.Title,ex.Title  

and click <OK>.  

9. Build the collection again, and preview it.  
10. Extracted metadata is unreliable. But it is very cheap! On the other hand, manually assigned 

metadata is reliable, but expensive. The previous section of this exercise has shown how to 
aim for the best of both worlds by using extracted metadata but correcting it when it is 
wrong. While this may not satisfy the professional librarian, it could provide a useful 
compromise for the music teacher who wants to get their collection together with a 
minimum of effort.  

Browsing by media type  

9. First let's remove the AZList classifier for filenames, which isn't very useful, and replace it 
with a browsing structure that groups documents by category (discography, lyrics, audio 
etc.). Categories are defined by manually assigned metadata.  

• Change to the Enrich panel, select the folder discography and set its dc.Format 
metadata value to "Discography". Setting this value at the folder level means that all 
files within the folder inherit it.  

• Repeat the process. Assign "Lyrics" to the html_lyrics folder, "Images" to images, 
"MARC" to marc, "Audio" to mp3, "Tablature" to tablature_txt, and 
"Supplementary" to wordpdf.  

• Switch to the Design panel and select the Browsing Classifiers section.  
• Delete the ex.Source classifier (the second one).  
• Add an AZCompactList classifier. Select dc.Format as the metadata field and 

specify "browse" as the buttonname. Click the sort checkbox, and select ex.Title in 
the drop-down list: this will make the classifier display documents in alphabetical 
order of title.  

Build the collection again and preview it.  

Note how we assigned dc.Format metadata to all documents in the collection with a minimum of 
labour. We did this by capitalizing on the folder structure of the original information. Even though 
we complained earlier about how messy this folder structure is, you can still take advantage of it 
when assigning metadata.  

Suppressing dummy text  

10. Alongside the Audio files there is an MP3 icon, which plays the audio when you click it, 
and also a text document that contains some dummy text. Image files also have dummy 
documents. These dummy documents aren't supposed to be seen, but to suppress them you 
have to fiddle with a format statement.  

• Change to the Format panel and select the Format Features section.  
• Ensure that VList is selected, and make the changes that are highlighted below. You 

need to insert five lines into the first line, and delete the second line. (Note, the 
changes are available in a text file, see below.) Change:  

<td valign=top>[link][icon][/link]</td> 
<td valign=top>[ex.srclink] 
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{Or}{[ex.thumbicon],[ex.srcicon]}[ex./srclink]</td>  
<td valign=top>[highlight] 
{Or}{[dls.Title],[dc.Title],[Title],Untitled}  
[/highlight]{If}{[ex.Source],<br><i>([ex.Source])</i>}</td>  

to this:  

<td valign=top> 
{If}{[dc.Format] eq 'Audio',  
   [srclink][srcicon][/srclink],  
   {If}{[dc.Format] eq 'Images',  
      [srclink][thumbicon][/srclink],  
      [link][icon][/link]}}</td>  
<td valign=top>[highlight] 
{Or}{[dls.Title],[dc.Title],[Title],Untitled} 
[/highlight]{If}{[ex.Source],<br><i>([ex.Source])</i>}</td>  

11. To make this easier for you we have prepared a plain text file that contains the new text. In 
WordPad open the following file:  
12. sample_files → beatles → format_tweaks → image_tweak.txt  

13. (Be sure to use WordPad rather than Notepad, because Notepad does not display the line 
breaks correctly.) Place it in the copy buffer by highlighting the text in WordPad and 
selecting Edit → Copy. Now move back to the Librarian Interface, highlight all the text that 
makes up the current VList format statement, and use Edit → Paste (ctrl-v) to transform 
the old statement to the new one.  

14. Preview the result. You may need to click the browser's <Reload> button to force it to re-
load the page.  

15. While we're at it, let's remove the source filename from where it appears after each 
document.  

• In the VList format feature, delete the text that is highlighted below:  

<td valign=top> 
{If}{[dc.Format] eq 'Audio', 
[srclink][srcicon][/srclink], 
{If}{[dc.Format] eq 'Images', 
[srclink][thumbicon][/srclink], 
[link][icon][/link]}}</td>  
<td valign=top>[highlight] 
{Or}{[dls.Title],[dc.Title],[Title],Untitled} 
[/highlight]{If}{[ex.Source],<br><i>([ex.Source])</i>}</td>  

16. Preview the result (you don't need to rebuild the collection.)  

Using AZCompactList rather than AZList  

17. There are sometimes several documents with the same title. For example, All My Loving 
appears both as lyrics and tablature (under ALL MY LOVING). The Titles browser might be 
improved by grouping these together under a bookshelf icon. This is a job for an 
AZCompactList.  

• Change to the Design panel and select the Browsing Classifiers section.  
• Remove the ex.Title classifier (at the top)  
• Add an AZCompactList classifier, and enter dc.Title,ex.Title as its metadata.  
• Finish by pressing <OK>.  
• Move the new classifier to the top of the list (<Move Up> button).  
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Build the collection again and preview it. Both items for All My Loving now appear under 
the same bookshelf. However, many entries haven't been amalgamated because of non-
uniform titles: for example A Hard Day's Night appears as four different variants. We will 
learn below how to amalgamate these.  

Making bookshelves show how many items they contain  

18. Make the bookshelves show how many documents they contain by inserting a line in the 
VList format statement in the Format Features section of the Format panel. The added 
line is shown highlighted below. The complete format statement can be copied from 
sample_files → beatles → format_tweaks → show_num_docs.txt.  

<td valign=top> 
{If}{[dc.Format] eq 'Audio', 
   [srclink][srcicon][/srclink], 
   {If}{[dc.Format] eq 'Images', 
     [srclink][thumbicon][/srclink], 
     [link][icon][/link]}}</td> 
<td>{If}{[numleafdocs],([numleafdocs])}</td>  
<td valign=top>[highlight] 
{Or}{[dls.Title],[dc.Title],[Title],Untitled} 
[/highlight]</td>  

Preview the result (you don't need to build the collection.) Bookshelves in the titles and 
browse classifiers should show how many documents they contain.  

Adding a Phind phrase browser  

19. In the Browsing Classifiers section on the Design panel, add a Phind classifier. Leave the 
settings at their defaults: this generates a phrase browsing classifier that sources its phrases 
from Title and text.  

Build the collection again and preview it. Select the new Phrases option from the 
navigation bar. Enter a single word in the text box, such as band. The phrase browser will 
present you with phrases found in the collection containing the search term. This can 
provide a useful way of browsing a very large collection. Note that even though it is called a 
phrase browser, only single terms can be used as the starting point for browsing.  

Branding the collection with an image  

20. To complete the collection, lets give it a new image for the top left corner of the page. Go to 
the General section of the Format panel. Use the browse button of URL to 'about page' 
image: to select the following image:  

sample_files → beatles → advbeat_large → images → flick4.gif  

Preview the collection, and make sure the new image appears.  

Using UnknownPlug  

In this section we incorporate the MIDI files. Greenstone has no MIDI plugin (yet). But that doesn't 
mean you can't use MIDI files!  
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21. UnknownPlug is a useful generic plugin. It knows nothing about any given format but can 
be tailored to process particular document types—like MIDI—based on their filename 
extension, and set basic metadata.  

In the Document Plugins section of the Design panel:  

• add UnknownPlug;  
• activate its process_extension field and set it to "mid" to make it recognize files 

with extension .mid;  
• Set file_format to "MIDI" and mime_type to "audio/midi".  

In this collection, all MIDI files are contained in the file beatles_midi.zip. ZIPPlug (already 
in the list of default plugins) is used to unpack the files and pass them down the list of 
plugins until they reach UnknownPlug.  

22. Build the collection and preview it. Unfortunately the MIDI files don't appear as Audio 
under the browse button. That's because they haven't been assigned dc.Format metadata.  

• Back in the Enrich panel, click on the file beatles_midi.zip and assign its dc.Format 
value to "Audio"—do this by clicking on "Audio" in the Existing values for 
dc.Format list. All files extracted from the Zip file inherit its settings.  

Cleaning up a title browser using regular expressions  

We now clean up the Titles browser.  

To do this we must put the Librarian Interface into a different mode. The interface supports four 
levels of user: Library Assistant, who can add documents and metadata to collections, and create 
new ones whose structure mirrors that of existing collections; Librarian, who can, in addition, 
design new collections, but cannot use specialist IT features (e.g. regular expressions); Library 
Systems Specialist, who can use all design features, but cannot perform troubleshooting tasks (e.g. 
interpreting debugging output from Perl programs); and Expert, who can perform all functions.  

So far you have mostly been operating in Librarian mode. We switch to Library Systems Specialist 
mode for the next exercise.  

23. To switch modes, click File → Preferences... → Mode and change to Library Systems 
Specialist. Note from the description that appears that you need to be able to formulate 
regular expressions to use this mode fully. That is what we do below.  

24. Next we return to our Titles browser and clean it up. The aim is to amalgamate variants of 
titles by stripping away extraneous text. For example, we would like to treat 
"ANTHOLOGY 1", "ANTHOLOGY 2" and "ANTHOLOGY 3" the same for grouping 
purposes. To achieve this:  

• Go to the Title AZCompactList under Browsing Classifiers on the Design panel;  
• Activate removesuffix and set it to:  

(?i)(\\s+\\d+)|(\\s+[[:punct:]].*)  

25. Build the collection and preview the result. Observe how many more times similar titles 
have been amalgamated under the same bookshelf. Test your understanding of regular 
expressions by trying to rationalize the amalgamations. (Note: [[:punct:]] stands for any 
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punctuation character.) The icons beside the Word and PDF documents are not the correct 
ones, but that will be fixed in the next format statement.  

The previous exercise was done in Library Systems Specialist mode because it requires the use of 
regular expressions, something librarians are not normally trained in.  

One powerful use of regular expressions in the exercise was to clean up the Titles browser. Perhaps 
the best way of doing this would be to have proper title metadata. The metadata extracted from 
HTML files is messy and inconsistent, and this was reflected in the original Titles browser. Defining 
proper title metadata would be simple but rather laborious. Instead, we have opted to use regular 
expressions in the AZCompactList classifier to clean up the title metadata. This is difficult to 
understand, and a bit fiddly to do, but if you can cope with its idiosyncrasies it provides a quick way 
to clean up the extracted metadata and avoid having to enter a large amount of metadata.  

Using non-standard macro files  

To put finishing touches to our collection, we add some decorative features  

26. Close the collection in the Librarian Interface (File → Close).  

27. Using your Windows file browser outside Greenstone, locate the folder  

sample_files → beatles → advbeat_large  

28. Open up another file browser, and locate the small beatles collection in your Greenstone 
installation:  

Greenstone → collect → smallbea  

smallbea is the folder name generated by Greenstone for this collection. You can determine 
what the folder name is for a collection by looking at the title bar of the Librarian Interface: 
the folder name is displayed in brackets after the collection name.  

29. Using the file browser, copy the images and macros folders from the advbeat_large folder 
into the smallbea folder. (It's OK to overwrite the existing images folder: the image in it is 
included in the folder being copied.) The images folder includes some useful icons, and the 
macros folder defines some macro names that use these images.  

To see the macro definitions, open the collection in the LIbrarian Interface (File → Open...) 
and view the Collection Specific Macros section in the Format panel.  

Using different icons for different media types  

30. Re-edit your VList format statement to be the following (in Format Features on the 
Format panel). You can copy this text from the file sample_files → beatles → 
format_tweaks → multi_icons.txt.  

<td valign=top>  
  {If}{[numleafdocs],[link][icon][/link]}  
  {If}{[dc.Format] eq 'Lyrics',[link]_iconlyrics_[/link]}  
  {If}{[dc.Format] eq 'Discography',[link]_icondisc_[/link]}  
  {If}{[dc.Format] eq 'Tablature',[link]_icontab_[/link]}  
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  {If}{[dc.Format] eq 'MARC',[link]_iconmarc_[/link]}  
  {If}{[dc.Format] eq 'Images',[srclink][thumbicon][/srclink]}  
  {If}{[dc.Format] eq 'Supplementary',[srclink][srcicon][/srclink]}  
  {If}{[dc.Format] eq 'Audio',[srclink]{If}{[FileFormat] eq 
'MIDI',_iconmidi_,_iconmp3_}[/srclink]}  
</td>  
<td> 
{If}{[numleafdocs],([numleafdocs])} 
</td> 
<td valign=top> 
[highlight] 
{Or}{[dc.Title],[Title],Untitled} 
[/highlight] 
</td>  

31. Preview your collection as before. Now different icons are used for discography, lyrics, 
tablature, and MARC metadata. Even MP3 and MIDI audio file types are distinguished. If 
you let the mouse hover over one of these images a "tool tip" appears explaining what file 
type the icon represents in the current interface language (note: extra.dm only defines 
English and French).  

Changing the collection's background image  

32. Nella cartella collect/smallbea (contiene tutti i dati della collezione) aprire,  nella cartella 
macros, il file file extra.dm usando l’applicazioone WordPad.  

Modificare la righe evidenziata sostituendo “beat_margin.gif” con “tile.jpg” : 

 
package Style 
 
_collectionspecificstyle_ { 
<style> 
body.bgimage \{ background-image: url("_httpcimages_/beat_margin.gif"); \} 
\#page \{ margin-left: 120px; \}   
</style> 
} 
 
package Global 
 
_icondisc_   {<img alt="_textdisc_"   title="_textdisc_"   
src="_httpcollection_/images/disc.gif">} 
_iconlyrics_ {<img alt="_textlyrics_" title="_textlyrics_" 
src="_httpcollection_/images/lyrics.gif">} 
_icontab_    {<img alt="_texttab_"    title="_texttab_"    
src="_httpcollection_/images/tab.gif">} 
_iconmarc_   {<img alt="_textmarc_"   title="_textmarc_"   
src="_httpcollection_/images/marc.gif">} 
_iconmidi_   {<img alt="_textmidi_"   title="_textmidi_"   
src="_httpcollection_/images/midi.gif">} 
_iconmp3_    {<img alt="_textmp3_"    title="_textmp3_"    
src="_httpcollection_/images/mp3.gif">} 
 
_textdisc_    {discography} 
_textlyrics_  {lyrics} 
_texttab_     {tablature} 
_textmarc_    {MARC record} 
_textmidi_    {MIDI audio} 
_textmp3_     {MP3 audio} 
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_textdisc_   [l=fr] {discographie} 
_textlyrics_ [l=fr] {lyrique} 
_texttab_    [l=fr] {tablature} 
_textmarc_   [l=fr] {MARC format} 
_textmidi_   [l=fr] {MIDI format} 
_textmp3_    [l=fr] {MP3 format} 

 

Queste line di codice specificano quale imagine di background deve essere usata. Copiare 
l’immagine tile.jpg dalla cartella sample_file/images/tile.jpg nella cartella 
collect/smallbea/images.  

33. Within WordPad, save extra.dm.  

34. Preview the collection's home page. The page background is now the new graphic.  

Other features can be altered by editing the macro files—for example, the headers and 
footers used on each page, and the highlighting style used for search terms (specify a 
different colour, use bold etc.).  

Building a full-size version of the collection  

35. To finish, let's now build a larger version of the collection. To do this:  
• Close the current collection (File → Close).  
• Start a new collection called large beatles (File → New...).  
• Base this new collection on small beatles.  
• Copy the content of sample_files → beatles → advbeat_large → import into this 

newly formed collection. Since there are considerably more files in this set of 
documents the copy will take longer.  

• Build the collection and preview the result. (If you want the collection to have an 
icon, you will have to add it from the Format panel.)  
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Parte XI – Adattamento della interfaccia utente 
Questa esercitazione sarà dedicata ad apportare alcune semplici modifiche all’interfaccia utente di 
Greenstone.  
 
Modifica della home page 
 
In questa prima parte sostituiremo la home page di Greenstone con una diversa home page. Per 
semplicità utilizzeremo una nuova home page già pronta, nel file yourhome.dm nella directory 
macros. 
Nel seguito indicheremo con GREENSONE la cartella nella quale è stato installato il sistema 
Greenstone (questa cartella è normalmente c:\program files\gsdl ) 
 

1. Con il file manager di Windows, aprire la cartella “GREENSTONE\etc” 

2. Aprire il file main.cfg (usare un qualunque editor di testo, ad es. wordpad). 

3. Individuare all’interno del file la seguente sezione 
macrofiles    tip.dm style.dm base.dm query.dm help.dm pref.dm about.dm \ 
              document.dm browse.dm status.dm authen.dm users.dm html.dm \ 
              extlink.dm gsdl.dm \ 
    english.dm english2.dm \ 
              french.dm french2.dm \ 
              spanish.dm spanish2.dm \ 
    russian.dm russian2.dm \ 
    home.dm collect.dm docs.dm bsummary.dm \ 
              translang.dm garish.dm 
 
Sostituire home.dm con yourhome.dm 
Salvare il file e chiudere WordPad. 

Con questa modifica abbiamo modificato la lista dei file di macro; in particolare, dal 
prossimo utilizzo della Biblioteca Greenstone verrà usato il file di macro yourhome.dm 
invece di home.dm 

4. Chiudere Greenstone o la Librarian Interface, se sono aperte. 

5. Aprire la Greenstone Digital Library. La home page ha una struttura completamente nuova. 

Nota: Nella cartella GREENSTONE\macros è già presente il file yourhome.dm che 
contiene i comandi per la creazione della home page. 

6. Creeremo ora una versione italiana di yourhome.dm 

7. Copiare la versione originale di yourhome.dm in home-it.dm (il file yourhome.dm 
si trova nella cartella “GREENSTONE\macros” 

8. Aprire con un text editor il file home-it.dm e tradurre in italiano tutte (o parte) le stringhe 
con testo in inglese. Nel seguito, le parti da modificare sono evidenziate in grassetto. 

 
package home 
_content_ { 
 
<h2>Your own Greenstone home page</h2> 
 
<ul> 
<table> 
<tr valign=top><td>Search page for the demo collection<br></td> 
    <td><a href="_httpquery_&c=demo">Click here</a></td></tr> 
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<tr><td>"About" page for the demo collection</td> 
    <td><a href="_httppageabout_&c=demo">Click here</a></td></tr> 
 
<tr><td>Preferences page for the demo collection</td> 
    <td><a href="_httppagepref_&c=demo">Click here</a></td></tr> 
 
<tr><td>Home page</td> 
    <td><a href="_httppagehome_">Click here</a></td></tr> 
 
<tr><td>Help page</td> 
    <td><a href="_httppagehelp_">Click here</a></td></tr> 
 
<tr><td>Administration page</td> 
    <td><a href="_httppagestatus_">Click here</a></td></tr> 
 
<tr><td>The Collector</td> 
    <td><a href="_httppagecollector_">Click here</a></td></tr> 
 
</table> 
</ul> 
 
} 
 
Salvare e chiudere il file. 

  
9. Aprire nuovamente il file main.cfg e sostituire yourhome.dm con home-it.dm 

quindi salvare il file. 

10. Chiudere le Digital Libraries Greenstone eventualmente aperte e far nuovamente partire la 
Digital Library Greenstone. La nuova home page visualizzata sarà in italiano. 

 
Modifica della home page 
 
In questa seconda parte dell’esercitazione modificheremo l’immagine di background della home 
page. 
 

11. Aprire la cartella “LOCAL_TEST\gsdl_extra” e, in un’altra finestra di windows aprire 
la cartella “GREENSTONE\images”. 

Copiare il file “usp_background.gif” dalla cartella gsdl_extra nella cartella 
images 

12. Nella cartella “GREENSTONE\macros” aprire il file base.dm (utilizzare un qualunque 
text editor). 

13. Individuare la seguente sezione 
_httpiconchalk_ {_httpimg_/chalk.gif} 
_widthchalk_ {2000} 
_heightchalk_ {10} 

e sostituirla con 
# Testo originale 

#_httpiconchalk_ {_httpimg_/chalk.gif} 
#_widthchalk_ {2000} 
#_heightchalk_ {10} 
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_httpiconchalk_ {_httpimg_/usp_background.gif} 
_widthchalk_ {1600} 
_heightchalk_ {70} 

Con (#) si indicano le righe di commento, che verranno ignorate da Greenstone. In questo 
modo potremo facilmente ripristinare la versione originale, non appena avremo terminato 
l’esercizio. 

Le nuove linee inserite specificano che la nuova immagine di background è 
usp_background.gif, e che la sua dimensione è di 1600x70 pixels. 

14. Salvare il file base.dm 

15. Chiudere le Digital Libraries Greenstone eventualmente aperte e far nuovamente partire la 
Digital Library Greenstone. La nuova home page visualizzata conterrà un nuovo sfondo. 

16. Con questa procedura è possibile creare degli sfondi personalizzati. Basterà creare, con un 
editore di immagini l’icona desiderata, e ripetere il procedimento appena descritto. 

17. Ripristinare la situazione iniziale, modificando nuovamente il file main.cfg e sostituendo 
yourhome-it.dm con home.dm e riportando il file base.dm alla situazione originale. 
Verificare che le condizioni iniziali siano state ripristinate. 
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Parte XII – Modifiche avanzate della interfaccia utente 
In questo ultimo esercizio modificheremo diverse parti della interfaccia utente della collezione di 
immagini. Modificheremo i seguenti file di macro: base.dm, english.dm, style.dm (tutti 
questi file si trovano nella cartella “GREENSTONE\macros”. Per poter ripristinare, alla fine 
dell’esercizio, le condizioni iniziali di funzionamento di Greenstone, copiamo questi tre file 

rispettivamente in base_org.dm, english_org.dm, style_org.dm. 

Al termine dell’esercizio copieremo i file base_org.dm, english_org.dm, 
style_org.dm in base.dm, english.dm, style.dm 

Facendo riferimento alla figura, modificheremo la parte (1), la parte (2), la parte (3) e la parte (4) 
dell’interfaccia. Cercheremo di creare una pagina (parzialmente) personalizzata per il corso di 
Informatica Umanistica della Biblioteca Greenstone. 
 
Modifica dell’immagine logo della collezione 

1. La modifica della parte (1) è gia stata sperimentata precedentemente. La procedura è la 
seguente: 

a. Copiare il file “inf_um_logo.gif” dalla cartella “LOCAL_TEST\immagini 
logo” nella cartella “GREENSTONE\collect\immagini\images” 

Nota: se, invece della collezione immagini si volesse modificare il logo di una 
diversa collezione di nome “nome_coll”, il file andrebbe copiato nella cartella 
“GREENSTONE\collect\nome_coll\images” 

b. Aprire il collector e richiedere la modifica di una collezione esistente (“work with an 
existing one, adding data to it or deleting it”). 

c. Selezionare la collezione di immagini. 

d. Selezionare l’opzione “configure collection”. 

e. Aggiungere le seguenti due righe  
collectionmeta iconcollection [l=en] 
"_httpprefix_/collect/image/images/inf_um_logo.gif" 

collectionmeta iconcollectionsmall [l=en] 
"_httpprefix_/collect/image/images/inf_um_logo.gif" 
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in fondo al file collect.cfg. Selezionare “Build Collection” e poi “View 
Collection”. Il nuovo logo è presente sia nella home page che nella collezione 
immagini. 

Nota: Questa modifica si può fare anche utilizzando la Greenstone Librarian 
Interface. 

 
 
Modifica dei bottoni in alto a destra nella pagina 

2. I bottoni che vengono visualizzati nella parte (2) della finestra sono controllati dalla macro 
_javalinks_ nel package Global nel file base.dm. Il valore corrente è 
_javalinks_ {_imagehome__imagehelp__imagepref__usability_} 

che visualizza tre bottoni, uno per il ritorno alla home page, uno per attivare l’help, ed uno 
per specificare le preferenze. 

La posizione nella quale vengono visualizzati i bottoni è specificata dalla macro 
_pagebanner_ nel file style.dm 

3. Modifichiamo la visualizzazione dei bottoni “home”, “help” e “preferences” modificando la 
macro _javalinks_ (si trova nel file base.dm) da 

 
_javalinks_ {_imagehome__imagehelp__imagepref__usability_} 

in 
_javalinks_ {_imagehome_<br>_imagehelp_<br>_imagepref_<br>_usability_} 
 
In questo modo i bottoni vengono visualizzati in righe diverse invece che 
sulla stessa riga. 

 
Modifica degli image header (parte (3) della figura) 
 
Le immagini dello header sono controllate dalla macro _imagethispage_. Questa macro viene 
inserita in tutti i package nei quali si vuole visualizzare l’immagine header. Per esempio, per 
visualizzare l’header per la pagina di “about”, nel package about (file about.dm) si ha la seguente 
macro: 
_imagethispage_ {<img src="_httpiconhabout_" width=_widthhabout_ 
height=_heighthabout_>} 
 
che specifica che l’immagine sorgente dell’icona è specificata dalla macro _httpiconhabout_, la 
larghezza dell’immagine è specificata dalla macro _widthhabout_, mentre la sua altezza è 
specificata dalla macro _heighthabout_ 
 
Queste macro si trovano nel file english.dm ed hanno i seguenti valori 
_httpiconhabout_ {_httpimg_/h\_about.gif} 
_widthhabout_ {200} 
_heighthabout_ {57} 
 
Se vogliamo modificare l’immagine di “about” (e analogamente per tutte le altre immagini che 
compaiono nello header) dobbiamo modificare queste macro. 
 
Le immagini degli header si trovano in file denominati h_imagename. Per esempio l’header per 
“about” si trova nel file h_about.gif nella cartella GREENSTONE\images. 
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4. Aprire la cartella GREENSTONE\images  

5. Aprire la cartella “LOCAL_TEST\immagini logo” e copiare il file 
h_about_inf.gif nella cartella GREENSTONE\images. 

6. Aprire il file english.dm e modificare la macro _httpiconhabout_ in 
_httpiconhabout_ {_httpimg_/h\_about_inf.gif} 

7. Aprire la Greenstone Digital Library e visualizzare la pagina “about”. Viene visualizzato il 
nuovo file. 

8. In modo analogo si possono modificare gli header delle pagine “search”, “subjects”, 
“author”, ecc. per personalizzare l’interfaccia utente. 

 
Modifica delle immagini nella navigation bar (parte (4) della figura) 
Ora modificheremo alcune immagini della barra di navigazione. Tutti i bottoni della barra di 
navigazione, eccetto il bottone di Search, sono controllati ed attivati dai classificatori definiti nel 
file collect.cfg (si veda parte IV delle esercitazioni). I bottoni che vengono visualizzati sono 
definiti nel package Global, nel file base.dm. Per esempio 
_imageTitle_ 
{_gsimage_(_httpbrowseTitle_,_httpiconttitlof_,_httpiconttitlon_,titles,_textima
geTitle_)} 

specifica che le immagini che vengono visualizzate per il titolo sono specificate nelle macro  
_ httpiconttitlof_,_httpiconttitlon_ 

Queste macro sono specificate nel file english.dm ed hanno la seguente forma: 
## "titles a-z" ## nav_bar_button ## ttitl ## 
_httpiconttitlgr_ {_httpimg_/ttitlgr.gif} 
_httpiconttitlof_ {_httpimg_/ttitlof.gif} 
_httpiconttitlon_ {_httpimg_/ttitlon.gif} 
_widthttitlx_ {87} 

e specificano la dimensione dell’immagine ed il nome del file. Da notare che ogni icona è costituita 
da tre immagini diverse, in tre diversi colori. L’immagine “ttitlgr.gif” contiene l’immagine che 
viene visualizzata quanto si è attivato il bottone, le altre due immagini corrispondono alla 
visualizzazione nel caso il bottone sia inattivo e quanto si passa con il mouse sopra al bottone. 
(Provare ad aprire la Greenstone Digital Library ed a verificare il comportamento dei diversi 
bottoni). 
Si può cambiare l’aspetto dello spazio tra le diverse immagini dei bottoni. L’immagine 
corrispondente a questo spazio si trova nel file tspace.gif ed è specificato nel file base.dm 
_httpicontspace_ {_httpimg_/tspace_inf.gif} 
_heighttspace_ {17} 

Modificando questo nome di file si possono utilizzare immagini diverse per la spaziatura. 

9. Copiare i file ttitlgr_inf.gif, ttitlof_inf.gif, ttitlon_inf.gif dalla 
cartella “LOCAL_TEST/immagini logo” nella cartella “GREENSTONE/images”. 
Questi tre file sono stati preventivamente creati con un editor di immagini. 

10. Aprire il file english.dm ed individuare la parte che specifica i nomi dei file per i titoli. 

11. Sostituire i tre nomi dei file nel seguente modo 
## "titles a-z" ## nav_bar_button ## ttitl ## 
_httpiconttitlgr_ {_httpimg_/ttitlgr_inf.gif} 
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_httpiconttitlof_ {_httpimg_/ttitlof_inf.gif} 
_httpiconttitlon_ {_httpimg_/ttitlon_inf.gif} 

_widthttitlx_ {87} 

12. Salvare e chiudere il file english.dm 

13. Copiare il file tspace_inf.gif dalla cartella “LOCAL_TEST/immagini logo” nella 
cartella “GREENSTONE/images”. 

14. Aprire il file base.dm ed individuare la sezione che specifica il nome dell’immagine di 
spaziatura. 

15. Modificare la riga nel seguente modo: 
_httpicontspace_ {_httpimg_/tspace_inf.gif} 

16. Salvare e chiudere il file. 

17. Qualora la Greenstone Digital Library fosse aperta, chiuderla. Riattivare nuovamente la 
Greenstone Digital Library e verificare i cambiamenti avvenuti nella visualizzazione dei 
bottoni della barra di navigazione. 

 
 
 
Importante: Al termine dell’esercitazione copiare i file 
base_org.dm, english_org.dm, style_org.dm in 
base.dm, english.dm, style.dm 
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Parte XIII – Creazione di Biblioteche Digitali  
Questa ultima parte viene utilizzata come verifica. Verrà proposta la creazione di alcune Biblioteche 
Digitali, per le quali verranno fornite le specifiche. 

Creazione di una BD contenente il materiale del corso. 
Questa esercitazione, nella quale creeremo una biblioteca digitale contenente parte del materiale 
distribuito e citato durante il corso, riprende alcune delle funzionalità provate nelle esercitazioni 
precedenti. Conseguentemente le istruzioni che vengono date sono volutamente sintetiche. 

Il materiale che verrà utilizzato nell’esercitazione può essere reperito nella cartella 
“LOCAL_TEST\Biblioteca Digitale Corso”. Il logo del corso di Informatica 
Umanistica si trova nella cartella “LOCAL_TEST\immagini logo” 

 
1. Creare la collezione contenente tutto il materiale del corso. Utilizzare i metadati Dublin 

Core. 

2. Per il metadato Subject associare valori a tutti i documenti di ogni cartella (ad es. ai 
documenti nella cartella lezioni associare il valore Lezioni) 

3. Aggiungere valori di metadati per Title, Creator, Subject, Description 

4. Creare un classificatore per la ricerca di frasi 

5. Creare un partition index per lezioni, articoli, manuali, riviste 

6. Creare un classificatore AZList per Title, Creator, Subject 

7. Aggiungere il logo di Informatica Umanistica 

 

Creazione di una BD di opere letterarie. 
Si provi a creare una BD contenente la descrizione di alcune opere letterarie. Si utilizzino i seguenti 
metadati Dublin Core: Titolo, Autore, Soggetto, Data, Descrizione, Casa editrice 

Si provi ad organizzare i soggetti in una struttura gerarchica (ad es. Letteratura, Storia, Scienze, ecc. 
con Letteratura composta di Prosa, Poesia, mentre Storia è composto di Storia antica, Medio Evo, 
ecc.) 

Creare dei classificatori per Titolo, Autore, Data, Soggetto, Casa editrice. 

Associare un’immagine ad ogni opera (per es. la copertina). 

Quando si visualizza l’opera verranno visualizzate tutte le informazioni associate. 

Provare a personalizzare la visualizzazione della BD, creando un’icona della DB e dei bottoni di 
browsing personalizzati. 


